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1. Introduction
Welcome to Papa Autoweb Pro — a powerful auto content engine yang dirancang khusus untuk
publisher WordPress profesional di Indonesia. Software ini membantu Anda menghasilkan artikel
berkualitas tinggi secara otomatis menggunakan teknologi AI terdepan, lengkap dengan optimasi
SEO Yoast, internal linking, dan publikasi langsung ke WordPress.

What This Software Does
• Multi-Agent AI Pipeline — Researcher, Writer, Editor, SEO Optimizer, dan Publisher bekerja
secara berurutan untuk menghasilkan artikel berkualitas

• Multi-Provider Support — Bekerja dengan NVIDIA NIM, OpenAI, OpenRouter, Anthropic, dan
Ollama (local)

• SEO Optimization — Otomatis isi field Yoast SEO (focus keyword, meta description, slug, alt
text gambar)

• Bilingual — Support penuh Bahasa Indonesia dan English dengan style profile yang berbeda

• Smart Features — Topic memory anti-duplikat, internal linking otomatis, Wikipedia external link,
scheduler harian

• Multi-Site — Kelola beberapa website WordPress dari satu tempat (Pro & Agency)

Who This Is For
Papa Autoweb Pro cocok untuk: blogger profesional, content creator, AdSense publisher,
agency digital marketing, dan content farm yang ingin scale up produksi konten tanpa
mengorbankan kualitas SEO.
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2. System Requirements

Component Minimum Recommended

Operating System Windows 10 Windows 11

RAM 4 GB 8 GB or more

Storage 500 MB free 2 GB free

Internet Stable connection Broadband

Python 3.10+ 3.11 or 3.12

Browser Chrome / Edge / Firefox Latest version

Note: Software ini bekerja sepenuhnya offline (kecuali saat mengakses AI provider, Unsplash, dan

WordPress). Tidak ada data Anda yang dikirim ke server kami selain saat aktivasi license.
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3. Installation

Step 1: Install Python
Software ini membutuhkan Python 3.10 atau yang lebih baru. Jika belum terinstall:

1. Buka https://www.python.org/downloads/

2. Download installer untuk Windows (versi 3.11 atau 3.12 disarankan)

3. Jalankan installer, centang "Add Python to PATH" di awal instalasi

4. Klik "Install Now", tunggu sampai selesai

5. Restart komputer untuk memastikan PATH ter-set

Verifikasi: Buka Command Prompt (Win+R, ketik cmd), jalankan: python --version. Harus

muncul Python 3.x.x.

Step 2: Extract Software
1. Download papa_autoweb_pro.zip dari link yang diberikan

2. Klik kanan file zip → Extract All

3. Pilih lokasi extract — disarankan path pendek tanpa spasi seperti C:\PapaAutoweb\

4. Hindari extract di Program Files, Desktop dengan path panjang, atau folder yang butuh admin

5. Pastikan struktur folder benar: hanya satu folder papa_autoweb_pro (jangan double-nested)

Step 3: First Run
1. Buka folder papa_autoweb_pro

2. Klik 2x file start.bat

3. Pertama kali jalan, akan auto-install dependencies (httpx, fastapi, dll) — tunggu beberapa menit

4. Setelah selesai, browser akan auto-buka di http://localhost:7890

5. Anda akan melihat dashboard Papa Autoweb Pro

Antivirus warning? Beberapa antivirus mungkin menampilkan peringatan untuk file .bat. Klik "Allow"

atau add ke whitelist. Software ini 100% aman dan open-source.



Papa Autoweb Pro - User Guide v2.0 Page 6

4. First Run & Configuration
Setelah berhasil membuka dashboard, Anda akan melihat beberapa tab di atas: Websites, AI
Provider, Features, Schedule, Tools, Activation, Update. Mari konfigurasi step by step.

Tab AI Provider
Pilih AI provider yang akan digunakan untuk generate konten. Disarankan mulai dengan NVIDIA NIM
karena gratis dan kualitasnya bagus.

Provider Free Tier Speed Quality

NVIDIA NIM Ya, generous Cepat Bagus

OpenRouter Limited Tergantung model Variasi

OpenAI Tidak (paid) Cepat Premium

Anthropic Claude Tidak (paid) Sedang Premium

Ollama (local) 100% gratis Tergantung GPU Tergantung model

Untuk setiap provider, Anda perlu: API Key (lihat Bab 5) dan Model Name. Untuk NVIDIA, model
yang disarankan: meta/llama-3.3-70b-instruct atau
nvidia/llama-3.1-nemotron-70b-instruct.

Tab Features
Di sini Anda mengatur API key untuk fitur tambahan dan toggle features. Beberapa fitur hanya
tersedia di Pro tier.

• Serper API Key — untuk topic research dari Google (gratis 2500 query/bulan)

• Unsplash Access Key — untuk featured image otomatis (gratis unlimited)

• Min Word Count — target jumlah kata per artikel (default 1000)

• Webhook Telegram/Discord — notifikasi setiap publish (Pro only)

• Internal Linking — link otomatis antar artikel (Pro only)

• Topic Memory — simpan riwayat untuk hindari topik duplikat
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5. Getting API Keys
Bab ini menjelaskan cara mendapatkan API key yang diperlukan. Semua yang disebutkan di sini
memiliki tier gratis yang cukup untuk pemakaian normal.

NVIDIA NIM API Key (Free)
NVIDIA menyediakan akses gratis ke berbagai LLM open-source seperti Llama, Mixtral, dll.
Kualitasnya bagus dan limit-nya cukup besar.

1. Buka https://build.nvidia.com/

2. Klik Sign In di pojok kanan atas

3. Daftar dengan email (atau login dengan Google)

4. Setelah login, pilih model — disarankan llama-3.3-70b-instruct

5. Klik Get API Key di sidebar kanan

6. Copy API key yang dimulai dengan nvapi-...

7. Paste ke field API Key di Tab AI Provider Papa Autoweb Pro

Serper API Key (Free 2500/month)
Serper.dev menyediakan akses ke Google Search API. Digunakan untuk topic research otomatis.

1. Buka https://serper.dev/

2. Klik Sign Up

3. Daftar dengan email atau Google

4. Setelah login, masuk ke Dashboard

5. Copy API key yang muncul

6. Paste ke field Serper API Key di Tab Features

Unsplash Access Key (Free)
Unsplash digunakan untuk mendapatkan featured image otomatis berdasarkan topik artikel.

1. Buka https://unsplash.com/developers

2. Klik Register as a developer

3. Buat akun atau login

4. Klik New Application

5. Setujui guidelines, isi nama aplikasi (misal: "Papa Autoweb")

6. Setelah app dibuat, scroll ke bagian Keys

7. Copy Access Key (bukan Secret Key)

8. Paste ke field Unsplash Access Key di Tab Features
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Tip: Unsplash demo limit 50 request/jam. Untuk volume tinggi, request promotion ke production

(unlimited, free) di dashboard Unsplash.

Telegram Bot Token (Optional, untuk Webhook)
Untuk notifikasi setiap kali artikel berhasil publish, Anda butuh bot Telegram pribadi. Fitur ini hanya
tersedia di Pro tier.

1. Buka Telegram, cari @BotFather

2. Kirim /newbot

3. Beri nama bot (misal: "My AutoPost Notifier")

4. Beri username bot (harus diakhiri "bot", misal: "myautopost_bot")

5. BotFather akan kasih bot token, simpan!

6. Cari bot Anda di Telegram, klik Start

7. Di Tab Features Papa Autoweb Pro, paste bot token

8. Klik Auto-detect Chat ID
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6. WordPress Setup
Untuk publish ke WordPress, Anda perlu setup 2 hal: Application Password dan Companion
Plugin (untuk SEO meta fields).

Step 1: Buat Application Password
1. Login ke WordPress admin (wp-admin)

2. Masuk ke Users → Profile (atau Pengguna → Profil)

3. Scroll ke bawah, cari section Application Passwords

4. Beri nama aplikasi, misal: "Papa Autoweb"

5. Klik Add New Application Password

6. WordPress akan tampilkan password (format: xxxx xxxx xxxx xxxx xxxx xxxx)

7. COPY DAN SIMPAN — password ini hanya muncul sekali!

Catatan keamanan: Application Password berbeda dengan password login utama. Jika bocor, Anda

bisa revoke lewat halaman yang sama tanpa mengubah password utama.

Step 2: Install Companion Plugin
Companion plugin diperlukan agar Papa Autoweb Pro bisa mengisi field SEO Yoast secara otomatis
(focus keyword, meta description, dll). Tanpa plugin ini, post tetap publish tapi field SEO kosong.

1. Di folder Papa Autoweb Pro, buka wp_companion_plugin/

2. Upload file papa-autoweb-companion.zip ke WordPress:

3.     Plugins → Add New → Upload Plugin → Choose File → Install Now

4. Setelah install, klik Activate

5. Plugin akan otomatis register SEO meta keys (Yoast, RankMath, AIOSEO)

6. Tidak ada konfigurasi tambahan yang diperlukan

7. Ulangi untuk setiap WordPress site yang akan dipakai

Step 3: Add Website di Papa Autoweb Pro
1. Buka Tab Websites

2. Klik + Add Website

3. Isi: URL (lengkap dengan https://), Username, Application Password

4. Pilih Language (id atau en)

5. Pilih Style Profile:

6.   • Storytelling — flowing, naratif (default Free)

7.   • Profesional — formal, otoritatif (Pro)

8.   • Informatif — fact-based, edukatif (Pro)
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9.   • Persuasif — sales/marketing tone (Pro)

10. Klik Test Connection — harus muncul ✓ Connected

11. Klik Check SEO — harus detect plugin SEO yang aktif

12. Tambah Categories sesuai topik website

13. Save
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7. License Activation (Free → Pro)

Tier Comparison

Feature Free Pro (Rp 199K) Agency (Rp 999K)

Websites 1 Unlimited Unlimited

Categories per site 2 Unlimited Unlimited

Style Profiles Storytelling only All 4 All 4

Webhook (TG/Discord) ✗ ✓ ✓

Auto-Scheduler ✗ ✓ ✓

Internal Linking ✗ ✓ ✓

Companion Plugin SEO ✗ ✓ ✓

Topic Memory ✓ ✓ ✓

Auto-Update ✓ ✓ ✓

Devices 1 1 (3x transfer) Unlimited

Price FREE Rp 199.000 lifetime Rp 999.000 lifetime

How to Upgrade to Pro/Agency
1. Hubungi admin via WhatsApp atau email support@begitusaja.my.id

2. Sebutkan tier yang diinginkan (Pro atau Agency)

3. Admin akan kasih nomor rekening / QRIS untuk pembayaran

4. Transfer Rp 199.000 (Pro) atau Rp 999.000 (Agency)

5. Kirim bukti transfer ke admin

6. Tunggu konfirmasi pembayaran dari admin

7. Buka Papa Autoweb Pro → Tab Activation

8. Input email Anda → pilih Tier (Pro/Agency) → klik Request Activation

9. Akan muncul token unik, contoh: ABC12345

10. Tunggu beberapa menit — admin akan approve via Telegram

11. App akan otomatis detect approval dan upgrade tier

12. Tier badge di header akan berubah dari FREE menjadi PRO atau AGENCY
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Refund Policy: Lifetime license, no refund after activation. Pastikan Anda sudah test Free version

dan paham fitur sebelum upgrade.

Transferring License to New Device
Jika Anda ganti laptop, install ulang Windows, atau upgrade hardware, license bisa di-transfer
(maksimal 3 kali transfer per lifetime untuk Pro tier; Agency unlimited devices).

1. Install Papa Autoweb Pro di device baru

2. Buka Tab Activation

3. Klik tab Transfer License

4. Input License Key (dari email konfirmasi atau dari device lama)

5. Input email yang sama saat aktivasi

6. Klik Transfer

7. License otomatis pindah ke device baru, device lama auto-deactivate
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8. Running Your First Pipeline
Setelah konfigurasi selesai, saatnya generate artikel pertama!

Pre-flight Checklist
■ AI Provider sudah ter-set dengan API key valid

■ Min Word Count sudah ditentukan (1000 disarankan)

■ Setidaknya 1 website ditambahkan

■ Test Connection website hasilnya ✓ Connected

■ Companion plugin terinstall (untuk Pro user yang pakai SEO)

■ Setidaknya 1 kategori per website ditambahkan dan enabled

Klik Tombol Start
Di bagian bawah dashboard, klik tombol Start Pipeline. Pipeline akan mulai jalan dengan urutan:

Step Process Estimasi Waktu

1 Test API Connection 5-30 detik

2 Topic Research (Serper) 10-20 detik

3 Article Writing (LLM) 30-90 detik

4 Editing &amp; Refinement 20-60 detik

5 SEO Optimization 10-30 detik

6 Image Search &amp; Upload 5-15 detik

7 Publish to WordPress 5-15 detik

<b>Total per artikel</b> <b>1.5 - 4 menit</b>

Monitor Progress
Saat pipeline jalan, Anda bisa monitor di area Live Logs. Setiap step akan ditampilkan dengan
timestamp dan status:

• system (biru) — Status sistem (start, stop)

• info (abu-abu) — Informasi umum

• agent (ungu) — Aktivitas AI agent

• success (hijau) — Operasi sukses (artikel published)

• warning (kuning) — Peringatan, pipeline masih lanjut
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• error (merah) — Error, pipeline mungkin skip atau berhenti

Tip: Klik Stop Pipeline kapanpun untuk hentikan. Artikel yang sudah berhasil publish tidak akan

di-rollback.
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9. Features Overview

Multi-Agent AI Pipeline
Setiap artikel melewati 5 AI agent yang berbeda untuk hasil optimal:

• Researcher — Cari topik trending dari Google via Serper, hindari topik duplikat

• Writer — Tulis artikel sesuai style profile, target word count, language

• Editor — Refine artikel, perbaiki grammar, tighten paragraphs

• SEO Optimizer — Generate focus keyword, meta description, slug, alt text

• Publisher — Upload ke WordPress dengan featured image dan kategori

Style Profiles (Pro)
Storytelling — Naratif, mengalir, cocok untuk lifestyle, personal blog, traveling. Pakai personal
pronoun, anekdot, dan emosi.

Profesional — Formal, otoritatif, cocok untuk B2B, bisnis, finance. Jargon yang tepat,
data-driven, struktur clear.

Informatif — Fact-based, edukatif, cocok untuk how-to, tutorial, science. Step-by-step, examples,
definisi.

Persuasif — Sales/marketing tone, cocok untuk product review, affiliate. Call-to-action kuat,
benefit-focused, urgency.

Topic Memory (Anti-Duplicate)
Software simpan riwayat semua topik yang pernah ditulis di data/memory.json. Saat research
topik baru, akan otomatis hindari yang mirip dengan riwayat. Cocok untuk publish konsisten tanpa
khawatir duplicate content.

Internal Linking (Pro)
Saat publish, software auto-scan artikel existing di website yang sama, lalu insert internal link relevan
di paragraf body. Bagus untuk SEO & user engagement.

Wikipedia External Link
Setiap artikel akan dapat 1 external link ke Wikipedia yang relevan dengan topik. External link
dengan kualitas tinggi membantu signal trust ke Google.

Auto-Scheduler (Pro)
Set jadwal harian, software otomatis jalan di waktu yang ditentukan. Cocok untuk fully automated
content calendar.

1. Buka Tab Schedule

2. Aktifkan toggle Enable Scheduler
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3. Set waktu (misal: 06:00) dan hari (misal: Senin, Rabu, Jumat)

4. Save schedule

5. Pastikan PC tidak shutdown — software harus running di background

Webhook Notifications (Pro)
Setiap artikel berhasil publish, dapat notifikasi langsung di Telegram atau Discord. Berisi judul artikel,
URL, dan status SEO. Bagus untuk monitoring tanpa cek WordPress dashboard.

Themes (4 Variasi)
• Glassmorphism — modern, frosted glass effect (default)

• Premium Dark — elegant dark mode dengan gold accent

• Minimalist Light — clean, distraction-free

• Nature Dark — earth tones, dark green/brown

Ganti theme di Tab Tools → Theme Selector. Available di Free dan Pro tier.

History & Analytics
Klik View History di header untuk lihat semua artikel yang pernah di-publish, lengkap dengan
timestamp, status SEO, link, dan kategori. Bisa export CSV.
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10. Auto-Update
Software ini support auto-update. Setiap kali ada bug fix atau fitur baru, Anda bisa update tanpa
download manual atau install ulang.

How to Update
1. Buka Tab Update

2. Klik Check for Update

3. Jika ada versi baru, akan tampil informasi: version baru, release date, size, changelog

4. Klik Download Update — tunggu sampai selesai

5. Setelah download, akan muncul instruksi: "Tutup app dan jalankan install_update.bat"

6. Tutup browser, tutup terminal start.bat (Ctrl+C atau close window)

7. Buka folder Papa Autoweb Pro, klik 2x install_update.bat

8. Tunggu sampai muncul "UPDATE BERHASIL!"

9. Jalankan kembali start.bat

10. Verifikasi version baru di Tab Update

Catatan: Folder data/ (config, history, license) akan otomatis di-backup dan di-restore. User data

Anda tidak akan hilang saat update.

Backup Folder
Setiap update, installer otomatis bikin folder data_backup_TIMESTAMP/ berisi backup data. Hapus
folder backup ini setelah yakin update berhasil dan semua jalan normal.
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11. Troubleshooting

Issue: start.bat tidak jalan
Solusi:

• Pastikan Python 3.10+ ter-install: cek dengan python --version

• Pastikan path folder tidak ada karakter aneh atau spasi panjang

• Try: klik kanan start.bat → Run as Administrator

• Cek antivirus apakah block .bat — add ke whitelist

Issue: Browser tidak auto-buka
Buka browser manual ke http://localhost:7890. Jika tidak loading, cek apakah ada aplikasi
lain yang pakai port 7890.

Issue: Test Connection WordPress gagal
• Pastikan URL website lengkap dengan https://

• Pastikan Application Password benar (bukan password login utama)

• Pastikan REST API WordPress aktif (cek yoursite.com/wp-json/)

• Jika hosting pakai Cloudflare/security plugin, mungkin block REST API — disable sementara

• Cek username — bukan email, tapi username login WordPress

Issue: Error "HTTP 415 Unsupported Media Type"
• Hosting block upload media. Solusi:

• Disable temporary security plugin di WordPress (Wordfence, iThemes, dll)

• Atau hapus Unsplash key di Tab Features — pipeline lanjut tanpa featured image

• Atau hubungi hosting support, minta whitelist REST API media endpoint

Issue: SEO Yoast field kosong setelah publish
• Pastikan Companion Plugin terinstall & aktif di WordPress

• Klik Check SEO di Tab Websites — harus detect plugin SEO

• Pastikan tier Anda Pro/Agency (Companion plugin support is Pro feature)

• Cek versi Yoast/RankMath terbaru — software mendukung versi stable terbaru

Issue: License revert ke Free secara tiba-tiba
• Internet mati lebih dari 7 hari (grace period habis) — connect internet, restart app

• Hardware berubah signifikan (ganti motherboard, CPU) — gunakan Transfer License

• Reinstall Windows — gunakan Transfer License

• Jika sudah pakai semua transfer (3x), hubungi admin via WhatsApp untuk reset

Issue: Pipeline lambat / hang
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• AI Provider sedang slow/down — coba ganti provider lain

• Internet tidak stabil — cek koneksi

• Pakai model yang lebih kecil/cepat (Llama 8B vs 70B)

• Restart app jika hang lebih dari 5 menit di satu step
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12. FAQ

Q: Apakah software ini benar-benar lifetime?
A: Ya, sekali bayar Pro/Agency, license berlaku selamanya. Tidak ada subscription.

Q: Apakah update fitur baru gratis?
A: Ya. Pro/Agency user dapat semua update gratis selamanya via auto-update.

Q: Bisakah saya cancel/refund setelah aktivasi?
A: Tidak. Lifetime license, no refund after activation. Test dulu Free version sebelum upgrade.

Q: Apakah konten yang dihasilkan benar-benar unik / pass plagiarism
check?
A: Ya. AI generate konten dari scratch, bukan scrape. Tested dengan Copyscape, Originality.ai dan
hasilnya unique.

Q: Apakah Google mendeteksi konten AI?
A: Mungkin. Tapi Google EEAT focus pada kualitas, bukan asal sumber. Pakai style profile yang
sesuai, edit manual sedikit, dan tambah personal touch untuk hasil terbaik.

Q: Bisakah dipakai untuk niche apapun?
A: Ya, semua niche legal. Beberapa niche seperti YMYL (medical, financial advice) butuh hati-hati &
manual review.

Q: Apakah API key yang saya pakai aman?
A: Ya. API key disimpan lokal di komputer Anda, tidak pernah dikirim ke server kami. Software ini
local-first.

Q: Bagaimana kalau saya mau cancel internet beberapa hari?
A: Tidak masalah. App ada grace period 7 hari offline. Setelah connect internet lagi, akan re-validate
otomatis.

Q: Apakah bisa dipakai di Mac atau Linux?
A: Saat ini hanya Windows. Mac/Linux support mungkin di versi mendatang.

Q: Berapa banyak artikel yang bisa di-generate per hari?
A: Tidak ada limit dari software. Limit hanya dari API provider Anda. Dengan NVIDIA NIM gratis, bisa
puluhan artikel per hari.
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Q: Apakah konten support semua bahasa?
A: Indonesia dan English fully supported. Bahasa lain bisa work tapi belum ditest extensively.

Q: Bagaimana kalau bot Telegram untuk aktivasi mati?
A: Hubungi admin via WhatsApp. Admin bisa manual approve via Google Sheet.

Q: Apakah saya bisa cetak konten lalu publish manual?
A: Software didesain untuk auto-publish ke WordPress. Tapi Anda bisa enable Draft Mode supaya
artikel save sebagai draft dulu, lalu Anda review & publish manual.
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13. Support & Contact
Butuh bantuan? Kami siap membantu Anda menyelesaikan masalah dan memberikan saran.

Channels

Channel Address Response Time

Email Support support@begitusaja.my.id 1-2 hari kerja

Website begitusaja.my.id/autoweb —

WhatsApp Admin (provided after purchase) Same day

Before Contacting Support
• Cek bab Troubleshooting di guide ini

• Cek bab FAQ

• Update ke versi terbaru via Tab Update

• Cek log error — copy lengkap untuk dikirim ke support

When You Contact Support, Include:
• Versi software (cek di Tab Update)

• Tier license (Free/Pro/Agency)

• Operating system & versi

• Deskripsi detail masalah

• Log error (copy dari Live Logs)

• Screenshot jika memungkinkan

• Steps yang sudah Anda coba

Thank you for choosing Papa Autoweb Pro!
Happy publishing & semoga bisnis Anda makin sukses.

This software is made with care by

PapaJahat Dev
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